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How to get DWARF Browser

DWAREF Browser is free for commercial use. DWARF Browser can be downloaded for Software Verify's
website at https//www.softwareverify.com/product/dwarf-browser/.

This help manual is available in Compiled HTML Help (Windows Help files), PDF, and online.

Windows Help https://www.softwarewverify.com/documentation/chm/dwarfBrowser.chm
PDF https://www.softwareverify.com/documentation/pdfs/dwarfBrowser. pdf
Online https://www.softwareverify.com/documentation/html/dwarfBrowser/index.htmi

Whilst DWARF Browser is free for commercial use, DWARF Browser is copyrighted software and is not
in the public domain.

You are free to use the software at your own risk.

You are not allowed to distribute the software in any form, or to sell the software, or to host the software
on a website.

Contact Software Verify at:

Software Verify Limited
Suffolk Business Park
Eldo House

Kempson Way

Bury Saint Edmunds
IP32 7AR

United Kingdom

email sales@softwareverify.com

web https://www.softwareverify.com

blog https://www.softwareverify.com/blog
twitter  http://twitter.com/softwareverify

Visit our blog to read our articles on debugging techniques and tools.
Follow us on twitter to keep track of the latest software tools and updates.
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2 What does DWARF Browser do?

DWAREF Browser allows you to inspect the DWARF symbols in an executable file.
You can sort the data, filter the data by name or by type of data.

You can also query the data by address which can be useful for identifying what function is at a given
address if all you hawve is a crash address and nothing else.

Query by address is supported three ways:
e Query by absolute address.
e Query by address offset from a DLL load address.

e Query by address offset from a symbol.
e Query using Windows event log XML crash data.

32 bit and 64 bit

DWARF data embedded in 32 bit executables and 64 bit executables are supported.

History

DWAREF Browser has been an internal tool at Software Verify for many years. We recently decided to
make it a bit more user friendly and to make it available for public use.
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3 What is a module?

A module is a contained block of executable code and data. For example, a DLL or EXE.
Some software vendors name their DLLs with different file extensions, for example .BPL, .ARX

When you call LoadLibrary to load a module, you are returned a HMODULE, which is an opaque handle
to a module. The HMODULE is most often the same as the module load address, but not always.

The lower few bits of the HMODULE can get OR'd with some flags to create a HMODULE value that is
not the same as the module load address.

You can get the load address of a module from it's HMODULE by masking out the lower 16 bits of the
HMODULE value then casting to a DWORD_PTR.

In this documentation when you read EXE or DLL or module, we are effectively referring to the same
thing. It's easier to read and write "DLLs" rather than "DLLs or EXE".
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4 Menu

The main menu contains five menus, File, Settings, Query, Software Updates and Help.

& DWARF Browser x64
File Settings Cuery Software Updates Help

41 File

The File menu controls loading of DLLs and debug information, clearing the display and exiting the
program.

Load DIl and debug information...
Close

Exit

File menu »> Load DIl and debug information... > loads a DLL and the debug information and
displays it.

File menu > Close » clear all results, unloads the DLL and debug information.

File menu » Exit » closes DWARF Browser.

4.2 Settings

The Settings menu controls editing of the settings controlling Exception Tracer

Edit Settings...

Settings menu » Edit Settings... > displays the settings dialog.

43 Query

The Query menu controls searching for symbols.

Find Syrmbol with Absolute Address...
Find Symbol with DLL Relative Address...

Find Symbol with Syrmbol Relative Address...

Find Symbol from Event Viewer XML crash leqg...

Copyright © 2021-2025 Software Verify Limited



10

DWARF Browser Help

44

Query menu * Find Symbol with Absolute Address... * use this option to turn an absolute address
in a process into a symbol, filename and line number.

See Decoding an absolute crash address for more details.

Query menu * Find Symbol with DLL Relative Address... *» use this option to turn a relative address
inside a DLL into a symbol, filename and line number.

See Decoding a relative crash address for more details.

Query menu * Find Symbol with Symbol Relative Address... * use this option to turn an address
that is relative to a symbol inside a DLL into a symbol, filename and line number.

See Decoding a symbol relative crash address for more details.
Query menu * Find Symbol from Event Viewer XML crash log... » use this option to turn an XML
crash log from the Microsoft Event Viewer to a symbol inside a DLL into a symbol, filename and line

number.

See Decoding an Event Viewer XML crash log for more details.

Software Updates

The Software Updates menu controls how often software updates are downloaded.

If you've been notified of a new software release to DWARF Browser or just want to see if there's a new
version, this feature makes it easy to update.

Check for software updates...
Configure software updates...

Set software update directory...

E Software Updates menu * Check for software updates » checks for updates and shows the
software update dialog if any exist

An internet connection is needed to be able to make contact with our servers.

= Before updating the software, close the help manual, and end any active session by closing
target programs.

If no updates are available, you'll just see this message:

Copyright © 2021-2025 Software Verify Limited
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Check for software updates. >

Software Update dialog

If a software update is available for DWARF Browser you'll see the software update dialog.

Software update download confirmation

A software update is available for DWARF Browser.

Do you wish to install DWARF Browser V1,162

Yes, Download and Install | Don't download, ask me later Skip this version, don't tell me about it again

Software update

Software update options... |

e Download and install > downloads the update, showing progress

Downloading DWARF Browser 1,16 *

Downloading DWARF Browser 1,16

8320 KB of 42084 KB (19.3%)

Once the update has downloaded, DWARF Browser will close, run the installer, and restart.
You can stop the download at any time, if necessary.

e Don't download... * Doesn't download, but you'll be prompted for it again next time you start
DWARF Browser

e Skip this version... * Doesn't download the update and doesn't bother you again until there's an
even newer update

e Software update options... > edit the software update schedule

Problems downloading or installing?

If for whatever reason, automatic download and installation fails to complete:

Copyright © 2021-2025 Software Verify Limited



12

DWARF Browser Help

¢ Download the latest installer manually from the software verify website.

Make some checks for possible scenarios where files may be locked by DWARF Browser as follows:
e Ensure DWARF Browser and its help manual is also closed
e Ensure any error dialogs from the previous installation are closed

You should now be ready to run the new version.

Software update schedule

DWARF Browser can automatically check to see if a new version of DWWARF Browser is available for
downloading.

E Software Updates menu * Configure software updates > shows the software update schedule
dialog

The update options are:

e never check for updates
e check daily (the default)
e check weekly

e check monthly

The most recent check for updates is shown at the bottom.

Software update schedule ? >

CutputDebugStringChedker can check for software updates on a regular basis.

" Mever check for updates
(" Chedk for updates every day
* Check for updates once a week

(" Chedk for updates once a month

Muost recent check for updates was performed on 2022-07-23

QK | Cancel

Software update directory

It’'s important to be able to specify where software updates are downloaded to because of potential
security risks that may arise from allowing the Tmp directory to be executable. For example, to
counteract security threats it's possible that account ownership permissions or antivirus software blocks
program execution directly from the Tvp directory.

Copyright © 2021-2025 Software Verify Limited
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The Tvp directory is the default location but if for whatever reason you're not comfortable with that, you
can specify your preferred download directory. This allows you to set permissions for Tmp to deny
execute privileges if you wish.

E Software Updates menu * Set software update directory * shows the Software update
download directory dialog

Software update download directory ? X

Software updates will be downloaded to the location specified below:
C:\Users'stephen\AppDataLocal Temp! Browse. ..

Reset
oK | Cancel |

An invalid directory will show the path in red and will not be accepted until a valid folder is
entered.

Example reasons for invalid directories include:
¢ the directory doesn't exist

¢ the directory doesn't have write privilege (update can't be downloaded)
¢ the directory doesn't have execute privilege (downloaded update can't be run)

E When modifying the download directory, you should ensure the directory will continue to be valid.
Updates may no longer occur if the download location is later invalidated.

o Reset » reverts the download location to the user's Tvpr directory

The default location is c:\users\ [username] \AppData\Local\Temp

4.5 Help

The Help menu controls displaying this help document and displaying information about DWARF
Browser.
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About 'WARF Browser...

Readme and Version History...

Help Topics..
Help POF...

Help on softwareverify.com...

Blzg...
Library...

Contact custorner support...

How do ...

Help menu > About DWARF Browser... > displays information about DWARF Browser.
Help menu * Readme and Version History... > displays the readme and version history.
Help menu * Help Topics... > displays this help file.

Help menu * Help PDF... » displays this help file in PDF format.

Help menu * Help on softwareverify.com... » display the Software Verify documentation web page
where you can view online documentation or download compiled HTML Help and PDF help documents.

Help menu > Blog... *> display the Software Verify blog.

Help menu * Library... > display the Software Verify library - our best blog articles grouped by related
topics.

Help menu *» Contact customer support... > displays the options for contacting customer support.
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Contact Software Verify Customer Support *
We provide customer support via email.

Email allows us to exchange detailed bug descriptions, detailed instructions, screenshots, log
files, crash dumps and other metadata that can't easily be communicated via telephone ar chat.

Should your support request require escalation to phone, Zoom or remote computer access we
will do that when required.

There are two methods to start a support request:

Email:

support@softwareverify.com

Website customer support form:
https: /fwww  softwareverify, com/suppart.php

Close

Click a link to contact customer support.

Help menu * How do I?... > displays the options for asking us how to do a particular task.

How do |7 »

How do I fly to the moon?
How do I make a purple cow?
How do I do X¥Z with DWARF Browser?

We can't help with the first two questions, but I think we can help with the last question.
we'l give you step by step instructions and/or a video showing you how to do XYZ,

Just send us an email describing what you're trying to do and we'll get right bacdk to you with a
solution,

Start a Support Reguest

Emiail:

support@softwareverify.com

Website customer support form:
https: /fwww . softwareverify, com/suppart/

Close
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5 The user interface

The DWARF Browser user interface is shown below.

& DWARF Browser x84 - O x
Fie Queyy Help
DL EcambugehBoiknd_TDS il i Teit] e - Loaded syniboks I~ Flaw symboinames  Mame Fiter Fiter
. [Name (662) Address [size [Type [Filename " Line Numbe
] TFarm!:ButtanExpandClick DxD000000000006360 69 g | TOS/C++Bui ppBuilderTest1/Unitl.cpp B3
10 TRorm{:ButtenRealiocClick CxD000000000006310 69 E/ombugs/Bordand TDS/C+ +Buildes/Skellett/ CppBuilderTest1/Unitl cpp | T8
1 TR 1:ButtonDeletarray Click :D0000GOD000062CD T E B TDS/C+ +Bui ppBuilderTest1/Unitl.cop | 72
12 TFarm:ButtonMewimayClick Ox0000000000006270 7O | TDS/C. i ppBuilderTest]/Unitl.cpp 67
5] TForm zButonDelereClick CDI000C0000006220 | T3 Evomvbugs/Borland TDS/C+ +Builder/Skellett/ CppBuilderTest)/Unitl.cpp | 61
4 TRaem :ButtanMallocClick xDI000COD0000GIED 58 E ge/B TOS/C+ +Buildes/Sh pBuilderTest1/Unitl.cop | 56
5 TFarm :ButtonMewClick DxD000000000006190 70 R i ‘ppBuilderTest1/Unitl.cpp 51
g/ Biors 5/C e+ Builder/ CppBuilderTest1/Unitl .cpp
17 Tharm1a~Tromnl CaDI0000D000006030 131 a /CppBuilderTest]/Unitl.cpp 31
® TFarm:TForm1 0xDIO00ODIO000SF0 240 3 i ppBuilderTest!/Unitl.cpp 23
19 wiVinMain xDO0000DI0DNISAFD 524 E i ‘pBuilderTest1/CppBuil.. 3
20 TFarmoz~TForm Ox00000000000067A0 B9 W 1274
2 TForme=TFarm DI0000D00006B00 211 gram files (x65) dia/21.0finclude/windowsivel/V... 1273
J(J T PeMAMMNVWIERCD 303 e Fu ) farrb s nel i 191 il ih P 1973 N e

Line Numbers: DWWARF:
Dusse _ |

Line 2...| Address Offset E-fcmvbugs/Borand_T0SCesBuida/Skalall CopBuldaiT eet] Alni.cpp Line 36

36 x0000D000DU00S0FD o Pl TEamfuh
(M000000000C005F

36 omiddoniesEr | Flush0
38 DxD00ODOOCO000E102 18 34 ¥ pehtas "
38 DxO000D00C0000E10A » 35
40 OxDOCO000000005110 32 ! l .

38 if (cMemory 1= NULL}
41/ Dx0000D00000006120 % 30

40 free(cMemory);
43 Dx000000000000612F 6 47 Themory o WAL
44/ Dr0000D00000006 14D 33 42 1

43 delete newdemory;
46 Dx0000DI000000615C 100 44 newnemary = NULL}

45
47 DeDOOODOO0O00017S 137 46 delete [1 newMemoryarray;
43 Ox00DDO000006 158 152 47 neEwMenar yArray = NULL;

The user interface consists of a main grid showing all main datatypes and functions in the debug help.

Below is a display for line numbers and a source code display for viewing the source code of any function
or variable that is selected.

Selecting any item in the grid populates the lower grid and source code display as appropriate.

Querying any value will select the nearest item in the main grid and populate the other displays as
appropriate.

Some basic filtering functionality is also provided.

DWAREF Information

® [Mama (44) " Addrass |size |[Filename [ Line Numbar
2 Trorm1:ButtonDeleteArray Click 49 / 1 TDS/C + Buibder/Skellett/CppBuilderTest1/Unitl .cpp 72

3 Trarm:ButtonDeleteClick 23 ! = _TDS/C ilderTest1/Unitl cpp |61

4 TForen1:ButtonExpandClick |_TDS/C+ + Builder,Skellett/CppBuilderTast1/Unit .cpp

& TFarm1:ButtonLeakC Click Borland_TDS/C~+Builder/Skellett/ CppBuildesTest]/Unitl cpp
T TForm:Buttonl eakCppClick 28 TOSC il i Initl.cpp
8 TFarm1:ButtonhallocClick B0 | 38 _TDS/C. ppBuilderTest]/Unitl .cpp
] TFarm!:ButtonhbsdupClick § E g §_TDS/Ce + Bui pRBuilderTest]/Unit! cpp
10 TFarm1:ButtonhesdrayClick [ 38 B |_TDA/C++B I ppBuildesTest1/Unit1

n TForm1:ButtonNewClick o038 g TOS/C e + Buikder/Skellett/CppBuilderTest1/Unit] cpp
12 TFarm1:ButtonfeallocClick 45 it |_TDS/C++B ilderTest1/Unitl .cpp
3 TForm1:ButtonStrdupClick [ TOS/C« + BuilderSkellett/CppBuilderTest1/Unit! .cpp
" TFarm1:ButtonTempnamClick &3 2/ g _TDS/C Test1/Unit! .cpp

15 Trarm:ButtonWesdupClick 6 E:/om/bugs/Borland_TIS/C -+ Buikder/Skellett/ CopBuilderTest1/Unit! cpp
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The DWARF information shows you the symbol name, symbol address, symbol size, and the filename
and line number for the symbol.

You can sort the data by clicking no the column header and clicking again to reverse the direction of the
sort.

If you select any item in the grid the lower grids and source code display are populated with data as
appropriate.

If you right click any item a context is displayed which will allow you to perform a symbol relative query.

Offzet from this symbol...

Copy filename and line number

Copy symbal, filename and line number
Copy all details

Highlight

Clear highlight

Clear all highlights

Line Numbers

Line Mumbers:

Line #... | Address Offset
42| (x00052E30
43| 000052E42
A4 | (wDD052E4B
45| (xD0052E58
46 0x00052E76

R =

The line numbers section lists each line number, the address of that line and the offset of that line from
the start of the owning function. Note that offsets can be negative as well as positive depending on how
the compiler did it's work.

Source Code

Copyright © 2021-2025 Software Verify Limited



The user interface 19

EAWARF Comy
Flename. £ fombugs /B oflard_TD5/C++Bulder/Shelett Coplddai T eal ] /Ui, oo Line 36
Fnchort  TFom] (b

Addrest Dy 00D0NO0MORIF]

28 MEWMEMOryArray = NULL: -
29 ¥

30

ES _Fastcall TForml: c~TForsi{)
a2 {

33 Flush{l;

34 T

35

gg 1f (oMemory '= NULL)

40 frealmenory);

41 CMEMOry = WULLZ

42 1

43 dalere newMemory;

44 MEWMEmary = MNULL:

The source code section displays the source code, highlights the selected line and displays information
relating to filename, line number, function and address.

Filters

M ame Filter: Filker |

Filtering by symbol name allows you to easily find a particular symbol. This is very useful when wanting
to decode a crash address that has been provided as relative to a symbol (symbol + offset).

DLLE TDSAC: Tt 10 irs4'\Debug'\CpoBulderT est] exe : Loadsd symboks ™ Raw symbel names Nama Fller, [dlocCick Filer
# Name (2) | Address Size | Filename [ Line Number
e P %
2 TForm 1:ButtonMallocClick k2] B d_TDS/C+= Buslder/Skellett/CppBuilderTest! Unitl.cpp | 56
Clipboard

Offzet from this symbol...

| Copy filename and line number

Copy symbal, filename and line number

Copy all details
Highlight

Clear highlight
Clear all highlights

Options on the context menu to allow you to copy the following information to the clipboard:

« Filename and line number. ThSort.pas 80
. Symbol, filename and line number. Thsort.TThreadSortForm.FormCreate ThSort.pas 80
o All symbol details. 4 Thsort.TThreadSortForm.FormCreate Unknownl4d (fast

this) 0x002F6B40 16 System.Types ThSort.pas 80

Copyright © 2021-2025 Software Verify Limited
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Highlighting

Offset from this symbaol...

Copy filename and line number
Copy symbaol, filename and line number

Copy all details

Highlight
Clear highlight
Clear all highlights

Options on the context menu allow you to highlight multiple symbols, and to remove highlights.

Highlighting can useful when you want to easily mark a symbol for future reference. Here's an example
image showing some symbols that have been highlighted.

#® [Name (44) Address |Size | Filenama [Line Number ~
4 TRom:ButtonExpandClick DOO0000N0NSCD 45 oS/ i /unitl.cop 8
5 Trarmi:ButtonfreeClick a8 1 i _TOS/C Test1/Unitl .cpp | B3
& Tromm1:ButtonLeakCClick 17 E:/s _TDS/C+ + Buibder/Skellett/CppBuilderTest1/Unitl .cpp 97
7 TFarm1:Buttonl eskCppClick 3 E: _TDS/C =+ Bui ilcterTest1/Unit].cpp | 103
3 Trorm1sButtonhaliocClick x00000000000057B0 38 s/ TDS/C++Bui ppBui Unitl cpp 36
9 TForm!:ButtenMbsdupClick [ 3 g |_TDS/C+ + Bui ilderTest1/Unitl.cpp | 138
10 Trorm1:ButtonNlewhrayClick G0000000000005820 3 E: TOS/C- - Bu i Wnitl.cpn 67
n Tr onhewClick 3 g TOS/C op pp 3
2 Trorm1:ButtonReallocClick O000000000000830 45 E:/omyvbugs/Borland_TDS/C+ B Mritl.pp T8
" TRorm:ButtonStrdupClick 5 Jom/bug TDS/Ce  Builder/Skellett/CopBuildesTest1 /Uit cpp | 110
& |_TDS/Cr+Bui i init].pp

i ilderTest1/Unit].cpp
iy Trarm1:TForm 203 a |_TDS/C+ Buibder/Skellest/ CppBuildesTest | Unitl cpp | 23
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6.1

Settings Dialog

Source Paths

The Source Paths settings allow you to specify where Dwarf Browser looks for source code files.

The source code paths are used when a filename is incomplete - a filename without a path, a filename
with a partial path, or a filename that isn't valid on this machine.

Settings

Settings

& Source Paths

.. Path Substitutions

Source Search Paths

Path
EvombcibuildMumber

ResctAl |

Reset

Help (F1)

o]

4l

~3
*

Remove

Remave All

Set Default

|

Cancel |

Manually adding path type directories

The Path list shows all the paths that will be searched for source code files.

You can modify the list of files for each path type in the following ways:
e Add » appends a row to the directory list * enter the directory path

Edit a directory path by double clicking the entry. The usual controls apply for removing list items:
* Remove * remowes selected items from the list

o Remove All * clears the list

o Set Default * adds all valid directories found in the PATH environment variable

Alternatively, press to delete selected items, and Ctrl o to select all items in the list first.

Copyright © 2021-2025 Software Verify Limited
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Reset - Resets all global settings, not just those on the current page. This includes removing any
symbol servers added.

6.2 Path Substitutions

The Path Substitutions tab allows you to specify file path substitutions to handle copying builds from
build machines to development or test machines .

The default settings are shown below:

Settings ? bt
Settings Path Substitutions
- Source Paths
e New Path  Old Path Add

Gihdevibuildy  Efom/bugs/Borland_TDS/C++Builder\Skellett

Remaove

Remaove All

I

£ >

Reset All Reset Help (F1) OK I Cancel

Path Substitutions

Some software development schemes have multiple rolling builds of their software, often enabled by
using substituted disk drive naming schemes.

When you download the build to your development machine for development and testing, debugging
information may reference disk drives that don't exist on your machine, for example, drive X: while your
machine only has C:, D:, and E: drives.

Or you may just be copying a build from a drive on a development machine to a subdirectory on a drive
on your test machine.

These options let you remap the substitution so that the DWARF Browser looks in the correct place for
the source code.

Copyright © 2021-2025 Software Verify Limited
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e Add * adds a row to the File Paths Substitutions table * enter the new path that will replace the
old path in the New Path column » click in the Old Path column » enter the path that is being
replaced

For example, you might enter c:\users\stephen\documents for the new path and f:\dev\build
for the old path.

You can double click to edit drives and paths in the table, or remowe items:
e Remove * remowes selected substitutions from the list

o Remove All » remowes all substitutions from the list

Alternatively, press m to delete selected items, and + to select all items in the list first.

Example: Changed disk drive

Project originally located at m:\dewvbuild\testApp

Project copied to e:\devbuild\testApp

New Path e\

Old Path m:\

Example: Project copied to a new location

Project originally located at f\dewvbuild\testApp

Project copied to C:\Users\Stephen\Documents\testApp
New Path C:\Users\Stephen\Documents

Old Path f\dewvbuild

E The slashes do not have to match, a forward slash will match a backslash when comparing path
fragments. This is deliberate - to improve ease of use with libraries built by different compilers (LLVM and
compilers that use it use forward slashes, whereas Visual Studio etc use backslashes).

Reset All - Resets all global settings, not just those on the current page.

Reset - Resets the settings on the current page.
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How to use DWARF Browser

Load DWARF information

To load Debug information you need to have the executable file containing debug information.

Use the File > Load DIl and debug information... option to load the appropriate DLL and it's debug
information.

The grid displays various attributes of each debugging item. You can sort the grid by clicking the
appropriate column header. Click the same header to reverse the sort order.

Select a symbol to see information about the parameters, locals, line numbers and source code.

Filtering

If you wish to only view one type of debugging data, select that datatype using the Tags combo.

You can also filter by name by typing the name into the Name Filter box and clicking the Filter button
to perform the filtering.

Viewing function data

As each item in the list is selected the Parameters and Locals grid are populated, the Line Numbers are
updated and the source code display updates to show the source code for the function. All lines in the
function that contain executable code (as indicated by the debugging information) are coloured grey. The
current line for the function is coloured bright green.

Querying data

You can query data by using the two Query fields below the main grid.

Relative query

Type the relative address (also know as address offset) into the Query by Offset field, then click Query.
The symbol information is displayed.

The field accepts decimal or hexadecimcal values. Hex values must be prefixed with Ox.

Absolute query

Type the absolute address into the Query by Address field, type the absolute DLL load address into the
Alternate Load Address field, then click Query. The symbol information is displayed.

The fields accept decimal or hexadecimcal values. Hex values must be prefixed with 0x.

Copyright © 2021-2025 Software Verify Limited



How to use DWARF Browser 27

7.1 Decoding an absolute crash address

Scenario:

A customer has supplied you with a crash report containing a callstack with addresses. The callstack
also indicates which module relates to which address.
The customer has also supplied you with a list of module load addresses.

Example Data:
Exception code: C0000005 ACCESS VIOLATION
Fault address: 0x005f5eec (base 0x00400000) C:\Program Files (x86)\Software Verification\
Exception Parameters:
0: 0x00000000 [Read Error]
1: 0x035f0034 [Address]

Registers:
EAX:035F0034
EBX:00000000
ECX:FFFDDO00O
EDX:00002370
ESI:006F7D58
EDI:035F0034
CS:EIP:0023:005F5EEC
SS:ESP:002B:0018FE14 EBP:0018FE3C
DS:002B ES:002B FS:0053 GS:002B
Flags:00010202

StackTrace

C:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe : 0Ox
C:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe : 0Ox
C:\Windows\syswow64\msvcrt.dll : 0x75D70000 : 0x75D7C3E4

C:\Windows\syswow64\msvcrt.dll : 0x75D70000 : 0x75D836B6

C:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe : Ox
C:\Windows\syswow64\kernel32.d1ll : 0x754D0000 : 0x754E3365

C:\Windows\SysWOWe64\ntdll.dll : 0x77920000 : 0x77959F6D

C:\Windows\SysWOW64\ntdll.dll : 0x77920000 : O0x77959F40

C:\Windows\SysWOW64\ntdll.d1ll : 0x77920000 : O0x77959F40

This is data from a real crash a few years ago, from C++ Memory Validator 5.80.

Question:
How do you decode these absolute addresses?

Answer:
In the above data we can see a callstack containing entries for ntdil.dIl, msvcrt.dll, and
memoryValidator.exe.

All the modules are Microsoft DLLs except for the EXE, which is part of C++ Memory Validator, one of
our tools.

To decode these values, we load memoryValidator.exe into DWARF Browser.exe, then for each symbol
we take the following actions.

Copyright © 2021-2025 Software Verify Limited



28 DWARF Browser Help

For our purposes here, we're going to show how to convert one symbol. We're going to use the first
symbol from memoryValidator.exe in the example data above.

0x005f5eec (base 0x00400000)

The address is 0x005f5eec. The DLL loaded at 0x00400000. You'll notice the load address for all
MemoryValidator.exe entries is 0x00400000.

From the Query menu choose Find Symbol with Absolute Address....

Find Symbol with Absclute Address...
Find Symbol with DLL Relative Address...

Find Symbol with Symbel Relative Address...

The Query Symbol by Absolute Address dialog is displayed.

Cuery Symbol by Absolute Address ? >

DLL:  memoryValidator. exe

DLL Load Address: |

What's a load address?

Address: |

Find Symbaol | Cancel

Type the DLL load address into the DLL Load Address field. Prefix any hexadecimal addresses with Ox.
Type the symbol address into the Address field. Prefix any hexadecimal addresses with Ox.

Click the Find Symbol button.

CQuery Symbol by Absolute Address ? >

DLL:  memoryValidator. exe

DLL Load Address: | 000400000

What's a load address?

Address: | 0x005f5eec

Find Symbaol | Cancel

The appropriate location in the code is found and displayed.
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CbgHelp.dll Copy |
Filenarme:  E:homhwchmemaona2itabzerhbdemarySettingD ata. cpp Line 5374 + 5 bytes

Function: MemomSettingD ata:: saveS oftwarell pdatel nformation

Addresz: O=06255EEC

5367 Py
5368 Eaid MemorySettingData: :saveCoverageFilters(CArchive &z
5369

5370 #1T _DO_NEW_COVERAGE_DATA

5371 DWORD 1, n;

5372 DWORD  schemaVersion;

5373

5375 ar << SE!EmaVEFS1DH:

5376 .

5377 n = coverageFilters.getNumItems();

5378 ar << n;

5379

5380 for{(i = 0; 1 < n; i++)

5381 { w
C23207 [ _ae—— i [P TR, [

< >
Results:

Repeating the process for the data shown abowe resulted in this information.

0x005f5eec (base 0x00400000) C:\Program Files (x86)\Software Verification\C++ Memory Valid
:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe : 0x
:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe : 0x
:\Windows\syswow64\msvcrt.dll : 0x75D70000 : Ox75D7C3E4

:\Windows\syswow64\msvcrt.dll : 0x75D70000 : 0x75D836B6

:\Program Files (x86)\Software Verification\C++ Memory Validator\memoryValidator.exe : 0x
:\Windows\syswow64\kernel32.d1ll : 0x754D0000 : O0x754E3365

:\Windows\SysWOW64\ntdll.d1ll : 0x77920000 : 0x77959F6D

:\Windows\SysWOW64\ntdll.dll : 0x77920000 : O0x77959F40

:\Windows\SysWOW64\ntdll.dll : 0x77920000 : O0x77959F40

OO OO OO IO ONQ!

Help! | have a crash address but | don't know what the load address is? What do | do?
You need to read about load addresses.

7.2 Decoding a relative crash address
Scenario:

A customer has supplied you with a crash report containing a callstack with relative offsets from DLLs.
The callstack also indicates which module relates to which address.

Example Data:
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Exception code: C0000005 ACCESS VIOLATION
Fault offset: 0x00036FA3 C:\WINDOWS\system32\MSVCRT.dl1l
Exception Parameters:

0: 0x00000000 [Read Error]

1: 0x5f8£f2000 [Address]

Registers:
EAX:B3BEB6D4
EBX:5F8CB6CS8
ECX:150BE5SBS
EDX:00000000
ESI:5F8F2000
EDI:01B98DEC
CS:EIP:001B:77C46FA3
SS:ESP:0023:0012F158 EBP:0012F160
DS:0023 ES:0023 FS:003B GS:0000
Flags:00010212

StackTrace

:\WINDOWS\system32\MFC42u.DLL : 0x0000270a

:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x000db989
:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x000dblf8
:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x00121a83
:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x00121b7e
:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x00174ec5

:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x00175094
:\WINDOWS\system32\MFC42u.DLL : 0x00013724
:\WINDOWS\system32\MFC42u.DLL : 0x00014245
:\WINDOWS\system32\MFC42u.DLL : 0x00001b31
:\WINDOWS\system32\MFC42u.DLL : 0x0008cba’

OO ONONONONONONONOINe]

This is data from a real crash many years ago.

Question:

There are no DLL load addresses and the addresses aren't addresses, but offsets from the start of a
DLL. How do you decode these relative offsets?

Answer:
In the above data we can see a callstack containing entries for mfc42u.dll, and memoryValidator.exe.

All the modules are Microsoft DLLs except for the EXE, which is part of C++ Memory Validator, one of
our tools.

To decode these values, we load memoryValidator.exe into DWARF Browser.exe, then for each symbol
we take the following actions.

For our purposes here, we're going to show how to convert one symbol. We're going to use the first
symbol from memoryValidator.exe in the example data above.

C:\Program Files\Software Verification\Memory Validator\memoryValidator.exe : 0x000db989

The relative address (or offset) is 0x000db989. We don't know the DLL load address.

From the Query menu choose Find Symbol with DLL Relative Address....
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Software update login details (Maint 1D 1107496136) ? X

To renew automatic software updates pou need to zpecify your login details.

These detailz were provided o you when you purchazed Performance Y alidator.

Email Address: |

Pazgwiord: |

(] 4 | Cancel

The Query Symbol by Absolute Address dialog is displayed.

Cuery Symbol by Relative Offset ? *

DLL:  memoryValidator. exe

Offset:

| Find Symbal | Cancel

Type the relative address into the Offset field. Prefix any hexadecimal addresses with 0x.

Click the Find Symbol button.

Cuery Symbol by Relative Offset ? >

DLL:  memoryValidator, exe

Offset:

| Find Symbaol | Cancel

The appropriate location in the code is found and displayed. In this example DWARF Browser could not
locate the source code (as the file location is not valid on this machine)
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CbgHelp.dll Copy |

Filename:  d:\WisualStudio'\WCISMAFCU N CLUDE \afsternpl.h Line 1270 + 3 bytes
Function: CMap<FiledndLine * FiledndLine * FiledndLine * FiledndLine * »::~Chap<FiledndLine * FiledndLine

Addrezs:  0x0B13E5933
1 Unable to open file:d:‘WVisualsStudio‘\VCI8\MFC,INCLUDE afxte A

Results:
Repeating the process for the data shown abowe resulted in this information.
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Exception code: C0000005 ACCESS VIOLATION
Fault offset: 0x00036FA3 C:\WINDOWS\system32\MSVCRT.dl1l

Exception Parameters:
0: 0x00000000 [Read Err
1: 0x5f8£f2000 [Address]

Registers:
EAX:B3BEB6D4
EBX:5F8CB6CS8
ECX:150BE5SBS
EDX:00000000
ESI:5F8F2000
EDI:01B98DEC
CS:EIP:001B:77C46FA3

or]

SS:ESP:0023:0012F158 EBP:0012F160

DS:0023 ES:0023 Fs:00
Flags:00010212

StackTrace

:\WINDOWS\system32\MFC42u
:\Program Files\Software
:\Program Files\Software
:\Program Files\Software
:\Program Files\Software
:\Program Files\Software
:\Program Files\Software

OO ONONONONONONONOINe]

:\WINDOWS\system32\MFC42u.
:\WINDOWS\system32\MFC42u.
:\WINDOWS\system32\MFC42u.
:\WINDOWS\system32\MFC42u.

3B

.DLL

Verification\Memory
Verification\Memory
Verification\Memory
Verification\Memory
Verification\Memory
Verification\Memory

DLL
DLL
DLL
DLL

GS:0000

0x0000270a

0x00013724
0x00014245
0x00001b31
0x0008cba’

Validator\memoryValidator.
Validator\memoryValidator.
Validator\memoryValidator.
Validator\memoryValidator.
Validator\memoryValidator.
Validator\memoryValidator.

7.3 Decoding a symbol relative crash address

Scenario:

A customer has supplied you with a crash report containing a callstack with symbol relative offsets from

DLLs. The callstack also indicates which module relates to which address.

Example Data:

33
exe 0x000db989
exe 0x000db1£8
exe 0x00121a83
exe 0x00121b7e
exe 0x00174ec5
exe 0x00175094
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ntoskrnl.exe!KeSynchronizeExecution+0x2246
ntoskrnl.exe!KeWaitForMultipleObjects+0x135e
ntoskrnl.exe!KeWaitForMultipleObjects+0xdd9
ntoskrnl.exe!KeWaitForSingleObject+0x373
ntoskrnl.exe!KeStallWhileFrozen+0x1977

ntoskrnl.exe! misaligned access+0x13f9
ntoskrnl.exe!KeWaitForMultipleObjects+0x152f
ntoskrnl.exe!KeWaitForMultipleObjects+0xdd9
ntoskrnl.exe!KeWaitForSingleObject+0x373
ntoskrnl.exe!NtWaitForSingleObject+0xb2

ntoskrnl.exe!setjmpex+0x34a3

ntdll.dll!ZwWaitForSingleObject+0xa
KERNELBASE.dll!WaitForSingleObjectEx+0x98

svlcoveragevalidatorstub x64.dll!sendCommandLineAndStartTimeToGUI+0x2868
svlcoveragevalidatorstub x64.dll!setValidatorFeedbackHookingComplete+0Ox1lfa6
svlcoveragevalidatorstub x64.dll!svl sendMessageRawToUserInterface+0x21837
svlcoveragevalidatorstub x64.dl1l!svl sendMessageRawToUserInterface+0x218cb
KERNEL32.DLL!BaseThreadInitThunk+0x22

ntdll.dll!RtlUserThreadStart+0x34

This is real data from a bug at Software Verify Ltd. This is one thread from many in a dump relating to a
deadlock bug we were investigating.

Question:
How do you decode these symbol relative offsets?

Answer:
In the above data we can see a callstack containing entries for ntoskrnl.exe, ntdll.dll, kernelbase.dll,
kernel32.dll and svicoveragevalidatorstub_x64.dll.

All the modules are Microsoft DLLs except for one DLL, which is part of C++ Cowverage Validator, one of
our tools.

To decode these values, we load sMCoverageValidatorStub_x64.dll into DWARF Browser.exe (64 bit),
then for each symbol we take the following actions.

For our purposes here, we're going to show how to convert one symbol. We're going to use the first
symbol from svCowerageValidatorStub_x64.dll in the example data abowe.

svlcoveragevalidatorstub x64.dll!sendCommandLineAndStartTimeToGUI+0x2868

Type the symbol name into the Name Filter field, then click Filter. This makes it easy to find the
symbol we want.

Tags: |A&lltags ﬂ MName Filter: [randlinetndStartTimeT oGUI Eilter I

Once we have found the symbol, right click on the symbol to display the context menu and choose
Offset from this symbol....
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' Offset from this syrnbol...

Copy filename and line number
Copy symbal, filename and line number

Copy all details
Highlight

Clear highlight
Clear all highlights

An alternate method is to click on the symbol to select it, then from the Query menu choose Find
Symbol with Symbol Relative Address....

Or, from the Query menu choose Find Symbol with Symbol Relative Address... then choose the
symbol you want from the combo box.

Find Symbol with Absolute Address...
Find Symbol with DLL Relative Address...

. Find Symbol with Syrmbol Relative Address...

Type the offset into the dialog (hex values must be prefixed with 0x) and click OK.

Cuery Symbol by Symbol Offset ? x

VLR - i CommandLine AndStar FTimeToGUI

Offset: | 0x00002863

Find Symbol I Cancel

The appropriate location in the code is found and displayed.
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DbgHelp.dll 6.3.59431.0 Copy
Filename: eomhchavicommonstubtsendworkeres. cpp Line 250
Function:  sendworkerE s sendWorkerProc
Address;  Ox000000000G07COSE
243 int rec; "
244 . .
245 // wait for the next entry on the queue, or until 1 se
246
247 if (!sendImmediately)
248 WaitForsingleObject (hQueueEvent, (DWORD)sendCountl
249
250  stubSingleLock Tlock(&workProclLock, TRUE);
251
252 [/ process queue
253 .
254 1t (sendwholeQueue) ]
255 rc = processQueue(hPipe, OverLapWrt);
256 else ]
257 rc = processCurrentQueue(hPipe, OverLapWrt); v
aCo
< b3
T EEEEEE———_—_—

Results:

Repeating the process for the data shown abowe resulted in this information.
svlcoveragevalidatorstub x64.dll!sendCommandLineAndStartTimeToGUI+0x2868
svlcoveragevalidatorstub x64.dll!setValidatorFeedbackHookingComplete+0Ox1fa6
svlcoveragevalidatorstub x64.dll!svl sendMessageRawToUserInterface+0x21837
svlcoveragevalidatorstub x64.dll!sv]l sendMessageRawToUserInterface+0x218cb

7.4 Decoding an Event Viewer XML crash log

Scenario:

A customer has supplied you with data from Windows Event Viewer about a crash. The log contains XML

and you don't know which values are relevant.
The event log data will have a provider name of "Windows Error Reporting” or "Application Error".
The XML data is found on the "Details" tab with the XML View radio box selected.

Example Data:
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<Event xmlns="http://schemas.microsoft.com/win/2004/08/events/event">

<System>
<Provider Name="Windows Error Reporting" />
<EventID Qualifiers="0">1001</EventID>
<Level>4</Level>
<Task>0</Task>
<Keywords>0x80000000000000</Keywords>
<TimeCreated SystemTime="2020-02-10T17:39:08.000000000Z" />
<EventRecordID>260219</EventRecordID>
<Channel>Application</Channel>
<Computer>hydra</Computer>
<Security />

</System>

<EventData>
<Data>2023787729086567941</Data>
<Data>1l</Data>
<Data>APPCRASH</Data>
<Data>Not available</Data>
<Data>0</Data>
<Data>testDeliberateCrash.exe</Data>
<Data>1.0.0.1</Data>
<Data>5e419525</Data>
<Data>testDeliberateCrash.exe</Data>
<Data>1.0.0.1</Data>
<Data>5e419525</Data>
<Data>c0000005</Data>
<Data>000017b2</Data>
<Data />
<Data />
<Data>C:\Users\stephen\AppData\Local\Temp\WERA1l4E. tmp.WERInternalMetadata.xml</Data>
<Data>C:\Users\stephen\AppData\Local\Microsoft\Windows\WER\ReportArchive\AppCrash_ testDeliber:
<Data />
<Data>0</Data>
<Data>3cc45263-4c2c-11ea-83d3-001e4£db3956</Data>
<Data>0</Data>
<Data>54756af49aec84£97c15£f03794£f£fd605</Data>

</EventData>

</Event>

This is data from a test program that is designed to crash.
Question:
There the event log indicates a DLL, but no load address, two different addresses, an exception code and

an offset from the start of the DLL. How do you decode this relative offset?

Answer:
DWAREF Browser has an option specifically for this occasion.

The XML data indicates the crash happened in testDeliberateCrash.exe. Load this into DWARF
Browser being sure to load the correct build version so that symbols match the crash addresses.

From the Query menu choose Find Symbol from Event Viewer XML crash log....
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Find Symbol with Absolute Address...
Find Symbol with DLL Relative Address...

Find Symbol with Syrmbol Relative Address...

Find Symbol from Event Viewer XML crash loqg...

The Query Symbol by Absolute Address dialog is displayed.

Event Viewer XML Crash Data

Paste your Event Viewer XML crash data here:

Find Symbal Cancel

Paste the XML data from the Event Viewer into the text field.

Click the Find Symbol button.
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Event Viewer XML Crash Data ? pod
Paste your Event Viewer XML crash data here:
<Event: P

£ >
Find Symbal Cancel

<Systems
<Provider Name="Windows Error Reporting”/>
<TimeCreated SystemTime="2021-11-03:10:31:0
</System=
<EventDatas
<Datax</Data>
<Data=</Data>
<Data=APPCRASH</Data>
=Datax</Data>
<Data=</Data>
<Data=E:\om\c\TestAppsitestDeliberateCrashyv
<Datax</Datas
<Data=</Datas
<Data=E:om\c'\TestAppsitestDeliberateCrashyv v

cNatase /Natas

The appropriate location in the code is found and displayed.

DbgHelp.dl Copy
Filename: ehomichtestappsttestdeliberatecrashitestdeliberatecrazhhtestdeliberatecrashdlg.cpp Line 171

Function:  CrestDeliberateCrashDlg:OnBnClickedOlk

Addrezs: Ox0IFO17E2

164 . . . ~
165 vold CtestDeliberateCrashDlg: :0nBnClickedok()

166

167 /f make a crash, don't close the dialog

168

169 DWORD #=ptr = MULL;

170

172
173

7.5 Whatis a load address?

A load address is the address at which a DLL loads.
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All versions of Microsoft Windows load modules (.dll, .exe) into address space that is reserved using a
call to VirtualAlloc().

The allocation of VirtualAlloc() can be queried by calling Win32 API GetSysteminfo() and examining the
value returned in dwAllocationGranularity. For all versions of Microsoft Windows this has been 64KB.
Why is the load address important?

The load address is important because without it we can't calculate the offset inside the DLL so that we
can obtain a symbol.

That's why a crash address with no DLL Load Address isn't very useful - we don't know which DLL the
crash is in, nor do we know where the DLL was loaded.
But | don't have a load address. What can | do?

Depending upon how your module (DLL/EXE) was built we may be able to guess the correct load
address.

If the OS you are using is Windows XP or earlier, we can guess the address.

First a brief chat about Address Space Layout Randomisation...

If the OS you are using is Windows Vista or later, we may not be able to guess the load address. The
reason this is not precise is because something known as Address Space Layout Randomisation
(ASLR) was introduced with Microsoft Vista to improve security against many malicious computer
attacks. Any program built with ASLR enabled when run on Vista (or later) will have the load address for
all modules (including the .exe) randomised, making guessing the load address a waste of time.

ASLR is enabled by the /[DYNAMICBASE in the linker settings of Visual Studio.

If you are using Visual Studio 2005 or earlier this setting is not available, your program is not affected by
ASLR.

If you are using Visual Studio 2008 or later you will need to check to see if this option is present. If it is
not present, your program is not affected by ASLR.

If you are not using Visual Studio to build your program then you may not be affected by this option,
consult your compiler/linker documentation.

If your program is not affected by ASLR...

We can try to guess the load address of your DLL/EXE. We can do this regardless of which

compiler/linker you used to build your program. All the programs | mention here are free to download at
the time of writing this help file.

VM Validator
https://www.softwareverify.com/cpp-virtual-memory.php
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This works for 32 bit and 64 bit programs.

Method 1
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e Start your program using VM Validator or attach to your running program with VM Validator.

e On the Summary tab, inspect the DLLs sub tab in the lower half of the display.
¢ Find the DLL name in the DLL column.
e The load address is the value in the Address column.

Method 2

e Start your program using VM Validator or attach to your running program with VM Validator.

e Go to the Paragraphs tab.
e Find any purple entry, check the DLL name in the Description field.

e The load address is the value in the Address column.

Summary XI| Virtual x]‘ Pages hei) Paragraphs
Address A‘ Size |Type ‘ Protect |Workir|g Set | Shared | Swap | Description
0x002C0000
0x002D0000 152 KB Private Reserved, Commited, Reserved
(00300000 1,024 KB Private Reserved
0x 00400000 1176 KB Image Read Only Read-only. Executable and read-only.  Shared: 98 eom\chdbgh exe
0x 00530000

In the example above, for dbgHelpBrowser.exe, the load address is 0x00400000.
Process Explorer
https://technet.microsoft.com/en-us/sysinternals/processexplorer.aspx
This works for 32 bit and 64 bit programs.

e Start your program

e Start Process Explorer. If your program is a service or runs as administrator you'll need to start

Process Explorer as administrator.

¢ In Process Explorer, enable View -> Show Lower Pane. Then for View -> Lower Pane Window,

choose DLLs.

e Select your program in the top window.

¢ Find your DLL in the bottom window. Right click. Choose Properties from the Context menu.

Copyright © 2021-2025 Software Verify Limited




42

DWARF Browser Help

(2 Process Explorer - Sysinternals: www.sysinternals.com [ZEUS\Stephen]
File Options View Process Find DLL Users Help

FIEIE =T IS e

I HEIH

Process CPU  Private Bytes Working Set  PID  Description Comparny Name
@ SecurityHealth Systray exe 1712K 8,704 K 11880 Windows Security notificatio... Microsoft Corporation
@, Onelrive exe 29012K 70728 K 12044 Microsoft OneDrive Microsoft Corporation
CIIWZQKPICK EXE 1496 K 8.108K 6852 WinZip Executable WinZip Computing, Inc
MTnotepad.exe 32K 16.952 K 308 Notepad Microsoft Corporation
2 &sv\launcher.exa 4696 K 12588 K 1052 sviLauncher Software Verify Limited - w...
gHelpBrowser exe 28420 K 51624 K 6840 dbgHelpBrowser
eventlogerashbrowser exe 12.48 5896 K 16,708 K 8836 Event Log Crash Browser Software Verify Limited - w...
vm\Validator exe 614 9664 K 21564 K 6188 vmValidator Software Verify Limited -w...
@HELPMJ\N.B{E 0.23 108,860 K 186,692 K 5396 Help & Manual EC Software GmbH
Name Description Company Name Path
DataExchange dll Data exchange Microsoft Corporation C:\Windows \SysWOW6E4\DataExchange dll
daveint dil Web DAV Client DLL Microsoft Corporation C:\Windows \SysWOWE4 \davelnt.dll
davhlprdi DAV Helper DLL Microsoft Corporation C:\Windows'SysWOWE4 \davhlpr.dll
dbgHelp.dll Windows Image Helper Microsoft Corporation E:'om'\cdbgHelpBrowser\Release'x 86 \dbgHelp dil
dbgHelpBrowser exe dbgHelpBrowser E:‘om‘c'dbgHelpBrowser\Release'x 86 \dbgHelp Browser.exe
deomp dil Microsoft DirectComposition Library ~ Microsoft Corporation C:\Windows\SysWOW6E4\dcomp dll
DevDispltemProvider.dil Deviceltem inproc devguery subsy... Microsoft Corporation C:WWindows \SysWOWE4\DevDisptemProvider.dll
devabj.dll Device Information Set DLL Microsoft Corporation C:\Windows \SysWOWE4 \devobj.dil
dinashext dll DLNA Mamespace DLL Microsoft Corporation C:\Windows \SysWOW6E4 \dinashext dll
drprov dil Microsoft Remote Desktop Sessio...  Microsoft Corporation C:\Windows \SysWOW6E4 \drprov dil

CPU Usage: 33.45% Commit Charge: 28.15% Processes: 193

¢ In the Properties dialog, read the load address.
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4| dbgHelpBrowser.exe Properties — O *

Image  strings

Image

Description:
Company: nfa

Version: 2.41.0.0

Build Time: Sun Jun 21 10:27:39 2020

Path:
| E:Yom'c\dbgHelpBrowser \Release w86 \dbgHelpBrowser, exe | Explore

Autostart Location:
|n,|"a | Explore
Load Address:  Ox0000000000400000 Werify

Mapped Size:  Ox 126000 bytes
Mapping Type: Image

VirusTotal: Submit

Image: 32-bit

Cancel

In the example above, for dbgHelpBrowser.exe, the load address is 0x00400000.
Visual Studio (any version)
https://www.visualstudio.com/
e Start Visual Studio.
¢ From the Project menu, choose File -> Open -> Solution. Choose your executable.
¢ From the Debug menu, choose Start Debugging.

e From the Debug menu, choose Windows -> Modules.

43
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¢ In the Modules window, find your DLL, then read the Address column.

Madules 3 X
Mame Path Optimnized User Code  Symbol Status Symbel File Or... Version Timestamg Address Process ™

] threadLockh... EN\omtcithreadLockChecker\Rele... Symbols leaded. EhomicithreadLockChec.. 1 18/05/2017 13:28 00130000-00204000

= aedildil CAWindows! SysWOWSd\ntdIldll N/A N/A Symbols leaded .. Ch\Users\stepher’ AppDat.. 2 6.3.0600.18..  10/02/2016 15:50 T7SADDOD-TITOF00D [TE72] e
] kemel32dil CAWIndows\ SysWOWSd kemel 32, N/A Y Symbols loaded ... ChLkssrs\stephentAppDat.. 3 6.3.0600.18.. 29/10/2014 02:58 T7300000-774D0000  [T&T2]t
4 KernelBase.dil CAWIndows\ SysWOWs KemelB..,  N/& MN/A Cannat find or a.. 4 63560018, 16/4Z01T 0%16 TSTCO000-T383TO00 1t
] sviEditToolAfe.. E\ombcithreadlockChecker\Rele.. N/A M/A Cannot find or o... 5 20,01 28/03/2017 21:50 GO3ADD00-60416000  [TE72] e
2 efSuppentdll Efvormie\threadLockChecker\Rele..  N/A N/& Cannot find oro.. 6 2001 28/03/2017 20:55 10000000-10010000  [T672] &
A mfc1 00wl CAWIndows\SysWOWEdmfc100..,  N/A NiA Symbols londed .. C\Users\stephent&ppDat... 7 10004021, 11/06/20711 04:28 T2060000- 724BF 000

A pnsver100.di CAWindows\SysWOWsSmswerll.,  N/A MN/A Symbols loaded. C:h\Users\stepher\AppDat.. B 10.00.4021...  11/06/2011 02:00 T3A50000-T3BOFD...

] user32dl CAWindows\SysWOWSH\user32dll - N/A N/ Symbols leaded .. Ch\Users\stepher’ AppDat.. 9 6.3.0600.16.. 09/11/2016 1825 T70EQO00-77233000

£ geh32.dil CAWindows\ SysWOWSd\gdid2dil - N/A N/A Symbols loaded .. ChLUsers\stephentAppDat.. 10 6.3.0600.18.. 07/04/2017 14:56 TADEDDOO- TAEEEDOD

4 advapi3l.dll CAWIndows\SysWOWsdadvapid.. NA& N/A Symbels loaded .. Ch\Users\stepher®AppDat.. 11 63960016, (471272073 15357 T3350000-733CC0.,,

& shel32.dil CAWindows\SysWOWSd\shell32dll  N/A M/A Symbols loaded .. Ch\Users\stepherAppDat.. 12 6.3.9600.17... 27/08/2016 17:00 75CA0000-TGEFBO...  [TE72)E
A los.ad? an mra hih ; 13 503 DEN 1 G4 FNAT N0 TSI TEZATAN (7RI e T
< >
] Modules

In the example abowve, for threadLockChecker.exe, the load address is 0x00130000.
WinDbg
https://msdn.microsoft.com/en-gb/library/windows/hardware/ff551063(v=vs.85).aspx

e Start WinDbg

e From the File menu, choose Open Executable. Choose your executable.

e Type Im, then press return.

e All modules are listed. Find your module. The start address is the load address.
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F E\om\c\dbgHelpBrowser\Release\x 86\ dbgHelpBrowser.exe - WinDbg:10.0,19041.1 86 - O x
File Edit View Debug Window Help
| = | B ELSHD 0O | N EEEEERGEEE] 8] A
Command n
gip=770asaas e=p=0019fa20 ebp=0019fadc iopl=0 nv up 2i pl =r na pe nc ~
oc==0023 ===002b d==002b e==002b {==0053 g==002hb ef1=00000246
ntdll!LdrpDoDebuggerBreak+0z2b:

770asaal co int 3

0.000: 1m

start end nodule name

no1do0000 oolfbkoon =wlPelnfo (deferred)

no400000 00526000 dbgHelpBrowser (deferred)

10000000 1000f£000 svlSupport (deferred)

73400000 73569000 gdiplus {deferred)

73650000 736b9000 HSWCE100 {deferred)

737a0000 73824000 COMCTL3Z2 {deferred)

73830000 73836000 HSTHG32 {deferred)

73e=0000 7431£000 nfcl0dn (deferred)

74350000 7440f000 MSWCR100 {deferred)

74420000 74428000 WERSIOH {deferred)

7470000 747ca00n CEYETEASE (deferred)

74740000 747f0000 S=piCli {deferred)

747£0000 74365000 zechost (deferred)

74870000 74967000 oled? {deferred)

74a=0000 74b9bo00 REPCET4 {deferred)

7dba0nnn 74bafonon kernel appocore (deferred)

74Eb0O000 74=29000 ADVAPTIZ {deferred)

7440000 74c9£000 borvptPrimnitives (deferred)

74400000 74417000 windZu {deferred)

74420000 752ec000 windows storage {deferred)

752f0000 752f6000 PSAFT {deferred)

7540000 75524000 SHIWAPT {deferred)

75640000 75747000 ISER3Z2 {deferred)

75720000 758c0000 EERHEL 32 {deferred)

75440000 Ytelf000 neEvert {deferred)

75=90000 76409000 SHELLIZ2 {deferred)

7480000 Fe504000 shoore {deferred)

76510000 76531000 GOIT32 {deferred)

76540000 7e55b0O00 profapi {deferred)

76570000 7eechbonn gdid2full (deferred)

7eed000n Ferefoon ucrthbase {deferred)

7e7£0000 7e7{fdO00 THEDC {deferred)

76800000 76813000 crypt=Ep {deferred)

76920000 76%ac000 EVCD Win (deferred)

769=0000 FechSO00 conbase (deferred)

7ece0000 FecizOonn OLEAUTZZ {deferred)

7ed0Oonnn 7ed43000 powrprof {deferred)

76d50000 7ed8bO00 cf gngril {deferred)

76d90000 7efSe000 EERNELBASE (deferred)

Trooooan ¥Y¥19a000 ntdll (pdb =vmbols) C:~ProgramData~dbg-~symn~wntdl
7b330000 7b451000 dbghelp {deferred)

Fhafonln 7ba?a0on =vlEditToolAfx (deferred)

]
< >
M:DDD>||

LnQ, Col0  Sys(<Local> Proc000:1bf0 Thrd 000:18dc  ASM  OVRE  CAPS  NUM

In the example above, for threadLockChecker.exe, the load address is 0x00130000.

Final Comments

OK, you should now know how to find the load address of a DLL or an EXE (or any module type).
Remember that a load address obtained this way is only valid for symbol decoding if the executable
doesn't have ASLR applied to it.
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If your crash reporting code only grabs crash addresses and not DLL load addresses, you need to
update your code so that you grab DLL load addresses at the time of the crash. That way you know for
sure what the load addresses were and you won't have to guess the load addresses in future.

Copyright © 2021-2025 Software Verify Limited






48

DWARF Browser Help

Command Line Interface

DWARF Browser can be used from the command line as well as with the GUI.

The command line options allow you to view DWARF debug information that is embedded in an
executable file, and optionally highlight a symbol at a specified offset.

[fileName
Specifies the module to load. This is typically a .exe or a .dll.

/fileName path-to-executable

Example: /fileName e:\om\c\test\release\test.exe
loffset

Specifies an offset inside the executable. DWARF Browser will highlight the symbol that
occupies this location.

Typically this offset will be calculated from a crash location.

For example:

If a DLL is loaded at 0x00400000 and a crash happens at 0x00420192, the offset is
calculated by subtracting the DLL load address from the crash address.

That is: 0x00420192 - 0x00400000, which gives 0x00020192.
The offset is 0x00020192.
The offset must be specified in hexadecimal with a leading 0x.
/offset value

Example: /offset 0x00020192

Example Command Line

32 bit applications
dwarfBrowser.exe /fileName e:\test\release\test.exe /offset 0x00020192

64 bit applications

dwarfBrowser x64.exe /fileName e:\test\releasel\test.exe /offset 0x00020192
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